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FeatureCAM 2014 R3 offers all of the original features of 
FeatureCAM 2014 R2, but with numerous improvements. The most 
significant improvements are detailed in the topics that follow. 

 FeatureCAM has three major enhancement releases per year 
(R1, R2, and R3) issued once every four months. This section 
describes what's new for FeatureCAM 2014 R3 and covers 
four months of development. To see a year's worth of 
development, please also see the What's New topics for the 
previous two releases. 

 What's New in FeatureCAM 2014 R2 (see page 22) 

 What's New in FeatureCAM 2014 R1 (see page 52) 

 
 

Milling improvements 
FeatureCAM 2014 R3 includes these Milling improvements: 

 Support for right-angled heads (see page 2). 

 Better transformation of surface milling features (see page 3). 

 You can use the standard thread sizes more easily (see page 4). 

 There is a new Thread Milled Hole feature type (see page 5). 

 You can manually define plunge points for Z level rough features 
(see page 5). 

 You can use cutter compensation by default for chamfer 
operations (see page 7). 

 You can specify default drill diameters for Reamed Holes (see 
page 8). 

 

What's New in 
FeatureCAM 2014 R3 
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Support for right-angled heads 
You can use right-angled machine tool heads for 2.5D Milling and 
Turn/Mill parts: 

 
This enables you to create difficult features, such as internal 
pockets, and enables you to create multiple features without 
repositioning the part. 

Selecting a tool holder for right-angled heads 

 You must use a solid to describe the tool holder shape for 
right-angled heads. 

To specify a tool holder for right-angled heads: 

1 In the Tool Holder Properties dialog, select Use solid to describe 
holder shape. 

2 Select the solid from the list. 

3 Select Angled Head. 

4 Select whether the Azimuth angle is Variable or Fixed. 

Using the right-angled head tool 
There is a new page of the Setup wizard. 
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Select the option on the Right Angled Head page of the Setup 
wizard: 

 
When selected, the Right Angled Head tab is displayed in the Feature 
Properties dialog for features which can use a right-angled head: 

 
Use right angle head — Select to use a right-angled head tool. 

Feature location is on ID — Select if the feature is on the inside 
diameter of the part. 

Holder orientation in spindle — Enter the holder orientation in the 
spindle in degrees. 

 

Better transformation of surface milling features 
You can now transform surface milling features which are created 
from solid faces. 
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Standard thread improvements 
You can use the standard thread sizes more easily in the New 
Feature wizard and Feature Properties dialog: 

 
To use a standard thread size, select Standard Thread and select a 
thread size from the list. You cannot edit the standard dimensions 
when Standard Thread is selected. 

You can click the blue dimensions labels to pick the values from the 
graphics window. 
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Thread Milled Hole feature type 
There is a new Thread Milled Hole feature type, which you can use 
to easily create Thread Milled Hole features and recognize them with 
Automatic Feature Recognition. 

Previously, you would have to create separate Hole and Thread 
features to create a Thread Milled Hole. 

On the Dimensions page of the New Feature wizard, select Thread 
Milled Hole from the type list to display the Thread Milled Hole 
parameters: 

 
You can add a thread to an existing Hole feature by changing the 
Type on the Dimensions tab of the Hole Feature Properties dialog. 

In the Hole Feature Properties dialog, you can use the Strategy tab to 
edit the Hole settings, and the Thread Mill tab to edit the Thread 
settings. 
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Manually define plunge points for Z level rough features 
You can manually define plunge points for Z level rough features. 

To define the plunge point: 

1 On the Leads tab of the Surface Milling Properties dialog, select 
Plunge to Pre-drill location, and enter a Drill diameter: 

 
2 Select the Plunge point(s) parameter on the Milling tab: 
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3 Enter the coordinates of a point, or click Pick location  and 
select a point in the graphics window. 

Alternatively, enter the name of a curve in the New Value field to 
place the plunge point at a point on the curve. 

4 Click Set to accept the selected point. 
 

Chamfer cutter compensation default 
You can use cutter compensation by default for chamfer operations. 

Select Chamfer cutter comp. on the Milling tab of the Machining 
Attributes dialog: 

 
When selected, Cutter comp. is enabled by default for chamfer 
operations on new features, and any existing features which use the 
default setting. 
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Specify default drill diameters for Reamed Holes 
For Reamed Hole features, you can specify the default tool diameter 
for all drill and bore operations in the feature. 

 Previously, these were calculated as a percentage of the 
Ream tool diameter. 

There is a new Drill diameter parameter on the Ream tab of the 
Ream Tool Properties dialog: 

 
If Calculated is deselected, you can enter a default Drill diameter 
value, which is used for the drill and bore operations in the feature. 

If Calculated is selected, the Drill diameter value is calculated from 
the Drill % of ream/bore attribute on the Tool Selection tab of the 
Machining Attributes dialog. 
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Turning improvements 
FeatureCAM 2014 R3 includes these Turning improvements: 

 You can specify separate approach and withdraw lengths for 
finish operations (see page 9). 

 Irrelevant parameters are hidden in the Feature Properties dialog 
when using Canned cycle (see page 10). 

 

Separate approach and withdraw lengths for finish 
operations 

You can control the approach and withdraw lengths separately for 
Turning finish operations. 

 Previously, you could only do this for rough operations. 

For example, this is useful for internal Bore features where you 
need to ensure the tool does not withdraw too far and gouge the 
part. 

There are new options on the Leads tab of the Turning Feature 
Properties dialog: 

 
When Use clearance as finish withdraw length is selected, the 
Clearance value is used as the approach and withdraw length for 
finishing moves. When deselected, you can enter a separate 
Withdraw length. 
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You can set the default values for these parameters on the 
Turn/Bore tab of the Machining Attributes dialog: 

 
 

Irrelevant canned cycle parameters hidden 
Irrelevant canned cycle parameters are hidden in the Turning 
Feature Properties dialog when they do not affect the toolpaths: 

 When Use canned cycle and TNR are selected on the Strategy tab, 
the Canned cycle Z clearance option is hidden on the Turning tab. 

 The Lead distance and Canned cycle X clearance parameters 
are used instead. 

 When Face is selected in the Strategy tab, the Canned cycle X 
clearance option is hidden on the Turning tab. 

 The Lead distance and Canned cycle Z clearance parameters 
are used instead. 
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Wire EDM improvements 
FeatureCAM 2014 R3 includes this Wire EDM improvement: 

 You can output multiple Setups as a single Program with a 
Program stop between Setups (see page 11). 

 

Generate single program with program stop between 
each setup 

For Wire EDM parts, you can output multiple Setups as a single NC 
program, instead of a separate program for each Setup. 

On the Indexing tab of the Stock Properties dialog, select Generate 
single program with stop between each setup: 

 
Program stops are added to the Operation List, allowing you to 
reposition the part between Setups, for example: 
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User Interface improvements 
FeatureCAM 2014 R3 includes these User Interface improvements: 

 You can replace curves when pasting features (see page 12). 

 The tool preview is oriented correctly for the selected machine 
type (see page 13). 

 You can pick radius values from cylindrical solids (see page 14). 

 You can quickly access the Stock settings from the Operations 
List (see page 15). 

 

Replace curves when pasting features 
When pasting a feature, you can replace the feature's boundary 
curve with a curve in the document. 

This enables you to quickly create custom features, without having 
to manually change the boundary curve for each feature. 

In the Paste Special dialog, select Paste the clipboard contents into 
the current setup... and click Next: 
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In the Select New Profile Curve(s) dialog, select any curves you want 
to use to create the feature and click Next: 

 
Use the Paste Special - Reference and Paste Special - Location dialogs 
to position the feature in the document. 

 If you select multiple curves in the Select New Profile Curve(s) 
dialog, a single feature is created for all curves, the same as if 
you select multiple curves when creating a feature using the 
New Feature wizard. 

 

Tool preview improvement 
The tool previews now display the tool in the correct orientation for 
the selected machine type. 

For example, when Slant bed lathe is selected on the Machine tab of 
the Viewing Options dialog: 
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3D simulation: 

 
Tool preview: 

 
 

Pick radius from cylindrical solids 
In the New Feature wizard and the Feature Properties dialog, you can 
click on a blue radius label and pick the value from a cylindrical solid 
in the graphics window. 

For example, the Bottom Radius parameter on the Dimensions page 
of the New Feature wizard: 
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Quick access to Stock settings from the Operation List 
You can quickly access the Stock settings from the Operation List. 
Right-click in the Operation List and select Stock from the context 
menu to display the Stock tab of the Feature Properties dialog for 
the operation. 

 This applies to Surface Milling features only. 
 

Import improvements 
FeatureCAM 2014 R3 includes these Import improvements: 

 You can position solids in 5-axis parts more easily (see page 15). 

 You can choose whether to import or ignore work planes (see 
page 15). 

 

Positioning solids in 5 axis parts 
You can position solids in 5 axis parts more easily when importing. 

On the Select Index Center of Rotation page of the Import wizard, you 
can enter the X, Y and Z coordinates of the center of rotation for 5 
axis parts: 

 

 Previously, you could only enter the Y and Z coordinates. 
 

Importing work planes 
You can choose whether to import or ignore work planes when 
importing solids into FeatureCAM. 
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Deselect Import work planes on the Solid Import tab of the 
Import/Export Options dialog to ignore planar surfaces when 
importing solids: 

 
 

XBUILD improvements 
FeatureCAM 2014 R3 includes these XBUILD improvements: 

 Faster machining times when using polar interpolation (see page 
17). 

 You can rename post variables (see page 17). 

 You can restrict machine movements greater than 360 degrees 
(see page 19). 

 There are new reserved words which determine whether the 
Euler angles have changed (see page 20). 

 There is a new reserved word which determines whether 
alternative 5 axis position is enabled (see page 20). 
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Faster machining times when using polar coordinate 
interpolation 

You can achieve faster machining times when using polar coordinate 
interpolation by canceling polar coordinate interpolation for rapid 
moves between cuts. 

You can use the following XBUILD reserved words to cancel polar 
coordinate interpolation: 
Reserved word Definition 
<POLAR-X> The transformed X coordinate for polar 

coordinate interpolation. This gives you 
flexibility to turn polar coordinate interpolation 
on and off when needed. 

<POLAR-Y> The transformed Y coordinate for polar 
coordinate interpolation. This gives you 
flexibility to turn polar coordinate interpolation 
on and off when needed. 

 
 

Post variable names 
You can rename post variables to make them easier to understand. 

By default, post variables are numbered sequentially: 

 
In the XBUILD dialog, select CNC-Info > Post Variable Names from the 
menu to display the Post Variable Names dialog. 
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You can enter a User-visible Name for each variable: 

 
The new variable name is displayed in the following places: 

 In the Post Variables list in FeatureCAM: 

 
 In any Formats which contain the variable, for example: 
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Restrict machine movements greater than 360 degrees 
For milling machines, you can specify whether the machine allows 
angles greater than 360 degrees. 

Select Restrict angles to be between -360 and 360 on the General 
Information dialog: 

 
When selected, moves which have rotations greater than 360 
degrees are split into smaller pieces. 
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Detect Euler angle changes 
There are new reserved words which determine whether the Euler 
angles have changed. 
Reserved word Definition 
<EULER-CHANGED> TRUE on any move where EULER-1, 

EULER-2, or EULER-3 has changed. This 
includes the Linear, Rapid, Canned 
Move, and Segment Start formats. In 
addition, <EULER-CHANGED> is TRUE for 
the Program Start and Tool Change 
formats if 4- or 5-axis indexing is 
enabled. 

<ABS-SHIFT-
CHANGED> 

TRUE on any move where ABS-SHIFTX, 
ABS-SHIFTY, or ABS-SHIFTZ has 
changed. This includes the Linear, 
Rapid, Canned Move, and Segment Start 
formats. In addition, <ABS-SHIFT-
CHANGED> is always TRUE for the 
Program Start and Tool Change formats.  

 
 

Detect if alternative 5 axis position is enabled 
There is a new reserved word which determines whether alternative 
5 axis position is enabled: 
Reserved word Definition 
<IS-ALT-POS> TRUE if alternate 5-axis position is 

selected.  
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Add-in improvements 
FeatureCAM 2014 R3 includes this add-in improvement: 

 There are new tags in the Setup Sheet add-in for finding the 
operation depth and minimum Z coordinate (see page 21). 

 

Setup Sheet add-in tags 
There are new tags in the Setup Sheet add-in: 

 {operation.depth} — Operation depth. 

 {.max_depth} — Minimum Z coordinate. 

For example, you can use {tool.max_depth}. 
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FeatureCAM 2014 R2 offers all of the original features of 
FeatureCAM 2014 R1, but with numerous improvements. The most 
significant improvements are detailed in the topics that follow. 

 FeatureCAM has three major enhancement releases per year 
(R1, R2, and R3) issued once every four months. This section 
describes what's new for FeatureCAM 2014 R2 and covers 
four months of development. To see a year's worth of 
development, please also see the What's New topics for the 
previous two releases. 

 What's New in FeatureCAM 2014 R1 (see page 52) 

 What's New in FeatureCAM 2013 R3 (see page 85) 
 

What's New in 
FeatureCAM 2014 R2 
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Vortex machining 
Vortex machining is an area clearance strategy that rapidly removes 
material from a 3D part while controlling tool load. Vortex is best 
suited to solid carbide tools and is frequently used in combination 
with step cutting. 

 
It is an offset-style toolpath and has these main features: 

 The engagement angle never exceeds, by more than 15%, that 
produced by a straight line cut with a given stepover. This 
eliminates excessive tool load and all full-width cuts. This 
enables you to increase feed rates. For other area clearance 
toolpaths, the cutting values are based on the tool 
manufacturer's slot cutting parameters to ensure the tool can 
sustain full cutting engagement. As the tool approaches the 
maximum engagement angle for optimum machining, the 
toolpath changes to a trochoidal path to avoid tool overload. 

 The machine tool almost always runs at the specified feed rate. 
With other area clearance toolpaths, the machine tool 
automatically slows down as it approaches a corner and the 
engagement angle increases. Vortex modifies the toolpath so the 
tool engagement angle is never exceeded and the machine tool 
achieves the specified feed rate. The only time the machine tool 
doesn't run at the specified feed rate is when the model 
geometry (a slot or corner) is smaller than the smallest radius 
that the machine can run at full speed. 

 Vortex machining cuts with the side of the tool so it is designed 
for solid carbide tools, but you may be able to use other tools. 
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 Because FeatureCAM controls the tool engagement, you can 
increase the depth of cut, which minimizes machining time. 

 Vortex machining is frequently used in combination with Step 
cutting to minimize terracing while maximizing the removal rate. 

 Vortex toolpaths are automatically checked for safety. 
FeatureCAM checks for: 

 plunges into stock. 

 excess tool engagement. 

 excess depth of cut. 

 small arc movements. 

To maximize the benefits of Vortex machining: 

 Configure the Vortex parameters to suit each machine tool. 

 Use Step Cutting (see page 25) to minimize terracing caused by 
the increased depth of cut. 

With optimum settings, Vortex machining greatly reduces machining 
times. 

 

Creating a 3D Vortex toolpath (3D HSM) 
To create a 3D Z-level roughing Vortex toolpath, select Vortex on 
the Strategy tab of the Surface Milling Properties dialog: 

 

 You must have the 3D HSM module to use Vortex for 3D Z-
level roughing. 

The following attributes are available for Vortex toolpaths in the 
Feature Properties dialog: 

F/S tab: 

 Feed — Enter the speed the tool cuts into the material. Vortex 
toolpaths are machined at this cutting feed rate almost all of the 
time. 
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Milling tab: 

 Vortex min point spacing — Enter the minimum point spacing at 
which the machine tool can move at the specified feed rate. If 
the machine tool has too many points to process, it cannot 
sustain the specified feed rate. 

 Vortex min radius — Enter the minimum radius of the internal 
trochoids. Vortex toolpaths use trochoidal moves to maintain a 
constant feed rate. Higher feed rates require a larger minimum 
radius. If you do not override this value, a default value is used, 
which is suitable for a typical machine tool at the feed rate 
specified for the operation. 

 Vortex Z lift distance — Enter a Z distance to lift the tool during 
trochoidal moves to avoid contact between the tool and the 
surface. 

 

3D Vortex example (3D HSM) 
This example shows you how to combine Vortex machining with 
step cutting to rapidly remove material. 

Because Vortex machining cuts with the side of the tool, it is 
designed for solid carbide tools, but there may be other types of 
tools suitable for Vortex. These tools work best when taking deep 
cuts with a relatively small stepover. 
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To machine effectively when taking large depths of cut, you must 
ensure the tool engagement angle never exceeds the specified 
value. This eliminates excessive tool load and all full-width cuts. 
FeatureCAM achieves this by introducing trochoidal moves to 
prevent the tool from exceeding the maximum tool engagement 
value. 
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Using a 3D model: 

 
Creating a Vortex toolpath without step cutting. 
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This removes vast quantities of material quickly, but leaves large 
terraces of unmachined stock on the part.  

 
You can minimize the size of these terraces using the Step cutting 
options. 
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This adds extra machining slices up the part. Looking at a detail of 
the side view: 

 
  Original Vortex pass 

  Step cutting passes 

It also machines more of the excess stock. 
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Creating a 2.5D Vortex toolpath (REC) 
To create a 2.5D Vortex toolpath, select Vortex from the Stepover 
list on the Strategy tab of the Feature Properties dialog: 

 

 You must have the FeatureRECOGNITION module to use 
Vortex for 2.5D roughing. 

The 3D HSM and 3D MX modules include 
FeatureRECOGNITION, 3D LITE does not. 

 You can use Vortex to machine most 2.5D feature types. 

You can use Vortex to machine a Side feature only if the curve is 
closed. If the curve is open and you select a Stepover of Vortex, NT 
Spiral is used instead. 

 

2.5D Vortex example (REC) 
This example shows how Vortex machines pockets, channels, and 
narrow corners.  

For more information on the general principles of Vortex machining, 
see the 3D Vortex and step cutting example (see page 25). 
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Using a 2.5D model:  

 
Create a Vortex toolpath: 
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For pockets, the tool spirals down into the pocket before using 
trochoidal paths over the full-width cuts. 

 
On completion of the initial full-width cut, the trochoids are placed 
in the corners where the maximum tool engagement angle would 
otherwise be exceeded. 

 
 

User Interface and work-flow 
improvements 

FeatureCAM 2014 R2 includes these User Interface and work-flow 
improvements: 

 There are icons in the Feature Properties dialog (see page 33). 
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 The cursor changes in the Operation List to show when additional 
actions are available (see page 33). 

 You can change the Post number of a Turret, and the new 
number is displayed throughout FeatureCAM (see page 34). 

 You can quickly rename items in the Part View (see page 35). 

 You can pick values from the graphics window in the UCS 
Translate dialog (see page 35). 

 The Tool Manager remembers the previously selected Tool Group 
(see page 36). 

 The edit boxes in the dialog bar are wider (see page 37). 

 Delcam Exchange is installed during the standard FeatureCAM 
installation (see page 37). 

 You can remove operations from a stock model (see page 37). 
 

Feature Properties dialog icons 
In FeatureCAM 2014 R2, the feature level tabs have icons in the 
Feature Properties dialog: 

 
 

Operation List cursor changes 
In FeatureCAM 2014 R2, when you move the cursor over an item in 
the Op List tab of the Results window, the cursor changes shape if 
additional actions are available. 

If the cursor changes to , you can double-click the item to 
display its associated dialog. 

For example, if you move the cursor over a tool name in the 
Operation List, the cursor changes: 
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Double-click the tool name to display the Tools tab of the Feature 
Properties dialog for the operation. 

 

Turret numbering 
If you change the post number of a turret in FeatureCAM 2014 R2, 
the new value is displayed throughout FeatureCAM so you can easily 
identify turrets. 

Enter a P Number in the Turret Information dialog: 

 
The new post number is displayed in the turret's name in the 
following places: 

 In the Part View panel: 

 
 On the NC Code tab of the Results window: 

 



 

FeatureCAM 2014 R3 What's New What's New in FeatureCAM 2014 R2 • 35  

 On the Turrets tab of the Results window: 

 
 

Renaming items in the Part View 
In FeatureCAM 2014 R2, you can rename items more easily in the 
Part View panel by clicking on a selected item: 

To quickly rename an item: 

1 Select an item in the Part View panel: 

 
2 Click on the selected item's name to make it editable: 

 
3 Enter a new name for the item. 

4 To accept the changes press the Enter key or click in the 
FeatureCAM window. 

To cancel the changes press the Esc key. 

 Double-clicking an item in the Part View panel displays the 
item's dialog, and does not rename the item. 

 

UCS Translate pick locations 
In FeatureCAM 2014 R2, in the UCS Translate dialog, you can pick 
the X, Y, and Z coordinates individually from the graphics window. 
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The X, Y, and Z labels are blue: 

 
Click a blue label to minimize the dialog, then select a point in the 
graphics window. 

The coordinate of the point is given to the selected item. 

For example, this is useful if you want to align a UCS with the 
center of a cylindrical face, with the depth along the cylinder (Z) 
defined using a different face. 

 

Tool Manager 
In FeatureCAM 2014 R2, the Tool Manager dialog remembers the 
previously selected Tool Group. 

If you select a Tool Group in the Tool Manager dialog, then close the 
dialog: 

 
The next time you display the Tool Manager dialog, the previously 
selected Tool Group is still selected: 
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 This applies only if you display the Tool Manager dialog by 
selecting Manufacturing > Tool Manager from the menu. If you 
display the Tool Manager dialog by clicking Tool manager  on 
the Tools tab of the Feature Properties dialog, the feature's 
default Tool Group is selected. 

 

Expanded dialog bar edit boxes 
In FeatureCAM 2014 R2, the edit boxes in the dialog bar are wider: 

 
This enables you to display more decimal places. 

 

Delcam Exchange installation 
In FeatureCAM 2014 R2, Delcam Exchange is installed during the 
standard FeatureCAM installation. 

 

Remove stock model operations 
In FeatureCAM 2014 R2, you can remove operations from a stock 
model. 

There is a new button in the Stock Model Properties dialog: 

 
Select an operation in the Stock model operation list and click  to 
remove it from the stock model. The operation is added to the 
Available operations list. 
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2.5D Milling improvements 
FeatureCAM 2014 R2 includes these 2.5D Milling improvements: 

 You can apply an NT stepover type to multiple passes of a 
feature (see page 38). 

 You can change the default ratio of Pitch to Thread Height for 
Thread Milling features (see page 39). 

 You can machine the bottom of a Counterbore Hole feature on 
the finish pass, and leave a Bottom finish allowance after the 
roughing pass (see page 40). 

 You can enable cutter compensation separately for a feature's 
operations (see page 41). 

 You can select Partline program and Finish cutter comp. 
independently (see page 42). 

 

NT toolpaths for multiple diameters 
In FeatureCAM 2014 R2, you can apply an NT stepover type to all 
roughing and finishing passes of a feature. 

Select an NT Stepover on the feature-level Strategy tab of the 
Feature Properties dialog to apply it to all roughing or finishing 
passes of the feature: 
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 Previously, selecting an NT toolpath type would apply it to the 
first pass only. 

 The Stock Model Settings dialog is available for the 
remachining passes on the Milling tab. 

 

Thread Milling ID/OD depth % 
In FeatureCAM 2014 R2, you can change the default ratio of Pitch to 
Thread Height for Thread Milling features. 

There are new options on the Thread Mill tab of the Machining 
Attributes dialog, OD Depth % and ID Depth %: 

 
The default value for OD Depth % and ID Depth % is 68. 

On the Dimensions tab of the Thread Milling Properties dialog: 
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The Thread Height  is calculated as a percentage of the Pitch , 
based on the OD Depth % or ID Depth % (depending on the Type 
selected). 

For example, if you enter an OD Depth % of 68, select a Type of OD, 
and enter a Pitch of 0.1, the Thread Height is updated to 68% of 0.1 
= 0.068. 

This also applies when creating a Thread Milling feature using the 
New Feature wizard. 

 

Bottom finish allowance for Counterbore features 
In FeatureCAM 2014 R2, you can machine the bottom of a 
Counterbore Hole feature on the finish pass, and leave a Bottom 
finish allowance after the roughing pass. 

In the Drill/Mill Options dialog, if Rough with Endmill, Finish with 
Endmill is selected, you can select Finish Bottom: 

 
When selected, the bottom of the Counterbore feature is machined 
on the finish pass, and the Bottom finish allowance option is 
available on the Milling tab of the Hole Feature Properties dialog: 
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Separate cutter compensation 
In FeatureCAM 2014 R2, you can enable cutter compensation 
separately for a feature's operations. 

Selecting Finish cutter comp. or Rough Cutter comp. on the Strategy 
tab of the Feature Properties dialog applies cutter compensation to 
the finish or rough pass only: 

 
To enable cutter compensation for an operation, such as a chamfer, 
select Cutter comp. on the operation's Milling tab: 

 
 



 

42 • What's New in FeatureCAM 2014 R2 FeatureCAM 2014 R3 What's New  

Finish cutter comp and Partline program independence 
In FeatureCAM 2014 R2, you can select Partline program and Finish 
cutter comp. independently on the Strategy tab of the Feature 
Properties dialog. 

 
This enables you to use partline program when cutter compensation 
is used for an operation in a feature, such as a chamfer, but not for 
the finishing operation. 

 If cutter compensation is not enabled for any of the 
operations in a feature, selecting Partline program does not 
affect the NC Code. 

 

3D Milling improvements 
FeatureCAM 2014 R2 includes these 3D Milling improvements: 

 You can specify the Offset Direction of a 3D offset toolpath (see 
page 42). 

 You can perform radial plunge milling (see page 44). 
 

Offset Direction 
In FeatureCAM 2014 R2, you can select whether a toolpath cuts 
from the inside out or from the outside in. 

There are new Offset Direction options on the operation-level 
Strategy tab of the Surface Milling Properties dialog for Offset 
toolpaths: 
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Select an Offset Direction from the following: 

 Automatic — The tool cuts from the outside to the inside of the 
stock in a continuous radial movement. This is the default option. 

 
During cutting: Cutting complete: 

  

 

 In to out — The tool plunges into the stock and cuts outwards. 

 
During cutting: Cutting complete: 

  
 

 Out to in — The tool cuts from the outside to the inside of the 
stock. The tool outlines the surfaces and cuts large sections last. 

 
During cutting: Cutting complete: 
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Radial Plunge Roughing 
In FeatureCAM 2014 R2, you can create a radial plunge milling 
toolpath using the radialPlungeMill add-in. 

To create a radial plunge milling toolpath: 
1 Load the radialPlungeMill.bas add-in. 

2 Create a surface milling feature using the surfaces you want to 
machine. 

3 In the Part View panel, deselect the surface milling feature to 
exclude it. 

4 In the New Feature wizard, select User in the From Feature section 
and click Next. 

5 Select RadialPlungeRough 1.0 in the Registered features list and 
click Next. 

6 Select Srf mill feature, enter the name of the surface milling 
feature in the New Value field and click Set. 

7 Follow the steps in the rest of wizard to modify the location and 
tool selection. 

8 Click Finish to close the dialog. 

New radial plunge milling features are given the name 
udf_radial_plunge_rough and numbered sequentially. 

 



 

FeatureCAM 2014 R3 What's New What's New in FeatureCAM 2014 R2 • 45  

Turning improvements 
FeatureCAM 2014 R2 includes this turning improvement: 

 Turning transfer operations are improved (see page 45). 
 

Transfer operation changes 
The Turning Sub-spindle features are being deprecated, and will be 
removed in a future release. For transfer operations use Part 
Handling features. 

In the New Feature wizard, the recommended Part Handling option is 
displayed at the top of the list: 

 
 

Wire EDM improvements 
FeatureCAM 2014 R2 includes this Wire EDM improvement: 

 You can project curves to different Z levels when creating Wire 
EDM features (see page 45). 

 

Project curves 
In FeatureCAM 2014 R2, you can project feature curves to different 
Z levels when using FeatureRECOGNITION to recognize a 4-Axis 
Wire feature from a solid. 
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This enables you to easily specify whether the feed and speed 
information is calculated from the feature height or the stock 
height. 

There are new options on the Dimensions tab of the Wire Feature 
Properties dialog and the Dimensions page of the New Feature wizard 
for Wire EDM features: 

 
Thickness — Enter the thickness of the feature, or click the blue 
label and select two points in the graphics window. The thickness is 
the depth below the feature curve. 

Project curves — Select this option to specify the upper and lower Z 
levels of the feature: 

 When deselected, feed and speed information is calculated based 
on the Thickness value. 

 When selected, feed and speed information is calculated based 
on the difference between the Upper Z and Lower Z values, and 
the Thickness is ignored. 

Upper Z — Enter the Z level of the top of the feature, or click the 
blue label and select a point in the graphics window. 

Lower Z — Enter the Z level of the bottom of the feature, or click the 
blue label and select a point in the graphics window. 

 To calculate feed and speed information based on the stock 
thickness, select the upper and lower stock boundaries as the 
Upper Z and the Lower Z values. 
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Machine design improvements 
FeatureCAM 2014 R2 includes these Machine Design improvements: 

 You can specify the locations of linear gang tools (see page 47). 

 You can send Machine Design files (.md) when sending other files 
(see page 48). 

 

Add Tool Location dialog improvements 
In FeatureCAM 2014 R2, there are additional options in the Add Tool 
Location dialog to make machine design for gang tooling easier 
(where the tool block holds tools in a linear pattern). 

On the Add Tool Location tab, you can select the Type: 

 
Select from: 

 Head — Add a single head tool. 

 Turret — Add multiple tools rotated about the LCS of the selected 
solid. 

 Gang — Add tools in a linear pattern. 
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Selecting a Type of Gang on the Add Tool Location tab enables you 
to enter the Tool Spacing and select the Direction on the For turning 
turrets tab: 

 
 

Send Machine Design files 
In FeatureCAM 2014 R2, there is an option in the Send Part Files 
dialog to send Machine design files (.md): 

 
This enables you to send the machine design files when sending 
other files. 

This is useful when reporting issues, especially for 5-axis and turn-
mill parts. 

Machine design files (.md) is selected by default. 
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Import improvements 
FeatureCAM 2014 R2 includes these Import improvements: 

 You can import SolidWorks 2014 files (see page 49). 

 SolidWorks Hole Recognition recognizes dowel holes in SolidWorks 
models, and machines them using a reamed hole operation (see 
page 49). 

 You can import SolidEdge ST5 and ST6 files (see page 49). 
 

SolidWorks 2014 files 
In FeatureCAM 2014 R2, you can import SolidWorks 2014 files. 

 This is dependant on the version of the swdocumentmgr.dll file, 
not the FeatureCAM version. 

 

Dowel holes 
In FeatureCAM 2014 R2, SolidWorks Hole Recognition recognizes 
dowel holes in SolidWorks models, and machines them using a 
reamed hole operation. 

To recognize a dowel hole: 

1 On the SolidWorks Hole Recognition page of the Import wizard, 
select Use SolidWorks to extract information about the hole types 
and dimensions. 

2 Click Finish to close the Import wizard. 

 Automatic Feature Recognition does not use a Ream operation 
for dowel holes imported from SolidWorks models. 

 

SolidEdge ST5 and ST6 files 
In FeatureCAM 2014 R2, you can import SolidEdge ST5 and ST6 
files. 
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XBUILD improvements 
FeatureCAM 2014 R2 includes this XBUILD improvement: 

 The CNC error message displays the line of code which causes 
the error (see page 50). 

 

Improved Error message 
In FeatureCAM 2014 R2, the CNC error message displays the line of 
code which causes the error, so you can find and fix the problem 
more easily. 

For example, if you enter the following code in the Program Start 
Format of a CNC file: 
PROGRAM-START<EOB> 
[: xyz abcd zzzzzzzzzzzzzzz + fabs(32.134564 ] 

The following error message is displayed when you test the CNC 
file: 
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Add-in Improvements 
FeatureCAM 2014 R2 includes this Add-in improvement: 

 In the Setup Sheet add-in, you can display whether cutter 
compensation is enabled for each operation (see page 51). 

 

Setup Sheet Cutter Compensation 
In FeatureCAM 2014 R2, in the Setup Sheet add-in, you can display 
whether cutter compensation is enabled for each operation. 

Add the variable tag {operation.cutter_comp} to the Setup Sheet 
template to display whether cutter compensation is enabled for 
each operation: 

 

 Click Help in the Setup Sheet Options dialog to display the 
Setup Sheet Help. 
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FeatureCAM 2014 R1 offers all of the original features of 
FeatureCAM 2013 R3, but with numerous improvements. The most 
significant improvements are detailed in the topics that follow. 

 FeatureCAM has three major enhancement releases per year 
(R1, R2, and R3) issued once every four months. This section 
describes what's new for FeatureCAM 2014 R1 and covers 
four months of development. To see a year's worth of 
development, please also see the What's New topics for the 
previous two releases. 

 What's New in FeatureCAM 2013 R3 (see page 85) 

 What's New in FeatureCAM 2013 R2 (see page 99) 
 

User interface improvements 
FeatureCAM 2014 R1 includes these user interface improvements: 

 There is more flexibility with naming features (see page 53). 

 You can now view and edit Layers (see page 53) in the Part View. 

 There are additional Part Documentation (see page 56) fields. 

 You can now send crash and performance logs (see page 58) by 
email. 

 You can change the location of a Setup aligned with a revolved 
surface to the opposite end (see page 57). 

 The more modern Shaded Grey (see page 59) user interface style 
is now the default. 

 The tool display window (see page 59) is now more attractive 
thanks to anti-aliasing. 

What's New in 
FeatureCAM 2014 R1 
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 Licensed product components are activated by default (see page 
60). 

 There are new license expiry warnings (see page 60). 
 

Feature names 
In FeatureCAM 2014 R1, you can use numbers at the start of 
feature names and include other characters such as spaces and %, 
for example 10mm hole pattern or pocket1 - 10% overload. 

 You must ensure that your post supports the characters that 
you want to use. 

Characters you can use: 
, comma 

. period 

" double quote mark 

/ slash 

- hyphen 

ALT+ code characters, such as Ø, ¼, ½, and so on. 
 

Layers in Part View 
In FeatureCAM 2014 R1, you can see Layers in the Part View: 

 
You can quickly show or hide layers using the check boxes. 

 System layer — You cannot edit a System layer, but you can 
show or hide it. 
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 User layer — Add your own layers to organize your work. To add 
a new layer, right-click on the Layers item and select New Layer 
from the context menu. 

 Current layer — New items are added to the current layer. 
Double-click on a user layer to make it the current layer. You 
cannot hide the current layer. 

Layers context menus 
Right-click on the Layers item in the Part View to display a context 
menu: 

 
New Layer — Select this option to create a new user layer. 

Show All Layers — Select this option to show the contents of all 
layers in the Graphics area. 

Hide All Layers — Select this option to hide the contents of all layers 
in the Graphics area. 

Layers — Select this option to open the Layers dialog. 

Right-click on a layer name in the Part View to display a different 
context menu: 

 
Show Layer — Select this option to show the contents of the layer in 
the Graphics area. 

Hide Layer — Select this option to hide the contents of the layer in 
the Graphics area. 

Set as Current Layer — Select this option to set the layer as the 
current layer. New items are added to the current layer. 

Rename — Select this option to rename the layer. 

Delete — Select this option to delete the layer. 
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Select Contents — Select this option to select the contents of the 
layer. This is useful, for example, if you want to move them to 
another layer. 

 The Set as Current Layer, Rename, and Delete options are 
unavailable for system layers. 

 

New Pick Curve buttons 
In FeatureCAM 2014 R1, there are several new Pick Curve  
buttons. This makes it quicker to set curves for the attributes. 
Previously you had to remember or copy-and-paste the curve name. 

For milling, there are new Pick Curve buttons for the Plunge points 
and Start point options on the Plunge tab: 
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For turning, there are new Pick Curve buttons for the Start point and 
End point attributes on the Turning tab: 

 
 

New Part Documentation fields 
In FeatureCAM 2014 R1, there are three new fields in the Part 
Documentation dialog: 

 
There are now dedicated fields for Company, Part/Drawing No., and 
Revision. You can use the Note 1, Note 2, and Comments fields for 
other information not covered by these fields. 
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 If you use the custom setup sheet add-in, these values are 
copied to the Setup Sheet Options dialog. 

 
 

Setup at opposite end of cylinder 
In FeatureCAM 2014 R1, you can change the location of a Setup 
aligned with a revolved surface to the opposite end: 
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Send crash logs 
There is a new option in the Send Part Files dialog: 

 
Select the Crash and performance logs option to create a separate 
.zip file of your system's crash and performance logs. 

Size confirmation 
If you are sending .zip files, a Size Confirmation warning dialog is 
displayed: 
The average email server limits attachments to 10 MB. 
The total size of the attachment(s) is: N (where N is the size of your 
attachment(s)) 
Would you like to continue sending? 

Click Send to attach the files to an email. 

Click Don't Send to keep the files on your desktop. 

Click Cancel to discard the files. 
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Shaded Grey default style 
In FeatureCAM 2014 R1, Shaded Grey is the default user interface 
style. You can change the style back to the previous style, Classic, 
or the alternative style, Glass, in the Customize Toolbars dialog. 

 
 

More attractive tool display window 
The display of tools and holders in the Tool Manager and Tool 
Properties dialog is now more attractive thanks to the use of anti-
aliasing in the tool display window.  

 If your graphics card or driver cannot support the anti-aliasing 
well, you can disable anti-aliasing in the tool window. There is 
a new Anti-alias tool window option in the Shading Options 
dialog. It is enabled by default. 
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Licensed components activated by default 
In FeatureCAM 2014 R1, the components that you have licensed are 
activated automatically. The new Activate all available product 
components option is selected by default: 

 
If you want to evaluate components that you have not licensed, 
select the Manually select product components option and select the 
components individually. 

 

License expiry warning 
Warning messages are now displayed when your license is nearing 
expiry so that you have time to make arrangements to renew the 
license. 
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Import improvements 
FeatureCAM 2014 R1 includes these import improvements: 

 OpenDesign AutoCAD (see page 61) upgraded. 

 Spatial R23 SP1 Interop (see page 61) integrated. 

 Spatial 3D R23 SP2 Interop (see page 61) integrated. 

 Import Using Exchange errors are logged (see page 61). 

 Support for entry-level solid wireframe import (see page 61). 
 

OpenDesign AutoCAD 
Upgraded to the latest OpenDesign AutoCAD import library, version 
3.09.0 (supporting DWG v2013). Includes multi-threaded loading. 

 

Spatial R23 SP1 Interop integrated 
Spatial R23 SP1 Interop is now integrated. 

 The Pro/E Reader component supports import of the User 
Defined Attribute (UDA) and the Name Attribute from Creo 1.0. 

 The Parasolid Direct Reader component supports v25 Parasolid. 

 Analytical faces from the NX Reader are no longer split. Only 
non-analytical faces are split at their seam. 

 

Spatial 3D R23 SP2 Interop integrated 
Spatial 3D R23 SP2 Interop is now integrated. 

 The CATIA V5 Reader/Writer component supports the 
import/export of CATIA V5 R23 parts and assemblies (Windows 
platforms only). 

 The NX Direct Reader component supports version NX 8.5 for 
only BREP and Assembly. 

 

Import Using Exchange logged 
Information from the Import Using Exchange feature is now stored 
in FeatureCAM's log file. 

 

Entry-level solid wireframe import 
In FeatureCAM 2014 R1, users of the basic 2.5D module can import 
solid models as wireframe using File > Import Using Exchange. 
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2.5D Milling improvements 
FeatureCAM 2014 R1 includes these 2.5D milling improvements: 

 You can automatically avoid clamps (see page 62). 

 You can do a Chamfer operation before a Finish operation (see 
page 65). 

 You can use a solid as a milling tool holder (see page 66). 

 Engraving fonts from onelinefonts.com (see page 66) are 
supported. 

 

Automatic clamp avoidance 
In FeatureCAM 2014 R1, you can automatically avoid solids that are 
set as clamps when using 2.5D NT-style toolpaths and 3D toolpaths. 

 You must use NT-style toolpaths for both the Rough and Finish 
operations to use this option for a 2.5D part. 

There is a new Clamp avoidance button on the Milling tab in 
Machining Attributes: 

 
Click the Clamp avoidance button to open the Clamp Avoidance 
dialog: 
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Automatic clamp avoidance — Select this option to automatically 
avoid solids that are marked as a clamp. To mark a solid as a 
clamp, right-click its name in the Part View and select Use Solids as 
Clamp in the context menu. 

 This option applies to 2.5D NT-style toolpaths and 3D 
toolpaths.You must use NT-style toolpaths for both the 
Rough and Finish operations to use this option for a 2.5D 
part. 

Allowance — Enter the minimum distance that you want to leave 
around clamps. 

Axial allowance — To set separate axial and radial allowances, select 
this option and enter the minimum axial (XY) distance that you 
want to leave around clamps. If you enable Axial allowance, the 
Allowance value is applied to the radial (Z) distance only. 

Example: 
This example bracket part is held in place by four clamps: 

 
With Automatic clamp avoidance disabled, there is a collision with the 
clamps in the bright pink areas: 
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Here is the back clamp in more detail, the front of the clamp has 
been machined away: 

 
With Automatic clamp avoidance enabled, the clamps are avoided: 

 
You can see the upstands of material, which have been left around 
the clamps: 

 
 



 

FeatureCAM 2014 R3 What's New What's New in FeatureCAM 2014 R1 • 65  

Chamfer before Finish 
In FeatureCAM 2014 R3, there is a new Chamfer before finish option 
on the Misc tab: 

 
Enable this option to do the Chamfer operation before the Finish 
operation. 

To enable Chamfer before finish: 

1 Select Chamfer before finish in the list of attributes. 

2 Select True from the New Value menu. 

3 Click the Set button to save the new value. 

The order of operations is updated in the feature Properties 
dialog and in the Op List. 
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Solid toolholder 
In FeatureCAM 2014 R1, you can use a solid to represent the tool 
holder for milling tools. This is useful for creating custom holders, 
where the holder cannot be described using a revolved curve. 

There is a new option in the Tool Holder Properties dialog: 

 
Select Use solid to describe holder shape and select the solid from 
the list. 

 

OLF engraving fonts 
In FeatureCAM 2014 R1, engraving fonts from our partner 
onelinefonts.com are supported. FeatureCAM ships with an 
incomplete test font to show that OLF fonts are recognized. You can 
purchase more fonts from http://onelinefonts.com. 
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Solid improvements (SOLID) 
FeatureCAM 2014 R1 includes these solid improvements: 

 You can now offset individual faces of a solid (see page 67). 
 

Offset faces 
In FeatureCAM 2014 R1, you can offset individual faces of a solid. 
There is a new Offset Faces solid constructor. 

To offset a face or faces of a solid: 

1 Open the Offset Faces dialog in one of these ways: 

 
 In the Solid Wizard, select Shape Modifiers, then Offset Faces, 

and click Next. 

 On the Solid toolbar, click the Offset Faces  button in the 
Modify solid menu. 

 From the menu, select Construct > Solid > Modifiers > Offset 
Faces. 

2 Optionally enter a Name for the solid, or leave the default name. 

3 Enter the Offset distance. A negative distance offsets the faces 
into the solid, a positive distance offsets the surfaces outwards. 

4 Select the name of the face you want to offset from the menu 
and click the Add item  button or click the Pick surfaces  
button and select the surface in the Graphics window. 

5 Optionally click the Preview button to see the results of the 
current settings in the Graphics window. 

6 Click OK (or Finish if you're using the wizard). 
 



 

68 • What's New in FeatureCAM 2014 R1 FeatureCAM 2014 R3 What's New  

Turn improvements (TURN) 
FeatureCAM 2014 R1 includes these turn improvements: 

 You can now do automatic corner rounding (see page 68). 

 There is now support for steady rest and tailstock (see page 70). 
 

Automatic corner rounding 
Programming turned parts is quicker and easier in FeatureCAM 2014 
R1. You can automatically deburr internal or external sharp edges of 
a Turn or Bore feature, without having to edit the geometry, using 
the new Fillet Radius setting. 

Enter a value to enable automatic filleting: 

 
If you enter a Fillet Radius value and click Apply, the Graphics 
window is updated, so you can preview the fillet. 

For example, no Fillet Radius: 
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With a Fillet Radius value applied: 

 
If you want to apply the fillet to internal instead of external corners, 
select the Other Side option: 

 
Automatic corner rounding works equally well for a Bore feature. 

For example, no Fillet Radius: 

 
With a Fillet Radius applied: 

 
If you want to apply the fillet to external instead of internal corners, 
select the Other Side option: 
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Steady rest and tailstock support 
FeatureCAM 2014 R1 supports the programming and simulation of 
steady rests and tailstock. Collisions with steady rests and tailstock 
are detected. 

This example part is 1.5 m long: 

 
Looking at a machine simulation, you can see that there is a long 
length of the part sticking out of the jaws: 

 
You can use a steady rest to support the part as you machine each 
feature. To use a steady rest, you create a Part Handling feature 
with a type of Part support on and a Support type of Steadyrest. 
In the example, the steady rest is turned on before the features at 
the end of the part are created. 

 
You can move the steady rest by creating an additional Part support 
on feature. 

In the example, the steady rest is moved further down the part to 
support the Turn operation: 
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An additional Part support on feature is created to move the steady 
rest back to the original position, to cut the other Turn feature and 
the Groove features: 

 
You can use a tailstock in a similar way. You create a Part Handling 
feature with a type of Part support on and a Support type of 
Tailstock. 

In the example, the tailstock is used to support the end of the part 
while the steady rest is supporting the middle: 

 
To send the steady rest or tailstock home, you create a Part 
Handling feature with a type of Part support off. 

To enable a steady rest: 
1 In the turning New Feature wizard, select the Part Handling 

feature and click Next. 
2 Select Part Support On and enter a value for the Grab distance. 

This is the distance in Z where you want to use the steady rest. 

3 Click Next. 
4 For the Support type, select Steadyrest. 
5 If your machine has multiple turrets, select the correct Transfer 

turret. 
6 If your steady rest is fitted to a turret, click the Turret control 

button and set the correct Index position. 

7 Click Finish. 

A part_support_on feature is added to the Part View. You may 
need to drag the feature to a different position in the Part View 
and set a Base priority for the feature to set the correct order of 
features. 
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To disable a steady rest: 
1 In the turning New Feature wizard, select the Part Handling 

feature and click Next. 
2 Select Part Support Off and enter a value for the Grab distance. 

This is the distance in Z where you want to use the steady rest. 

3 Click Next. 
4 For the Support type, select Steadyrest. 
5 If your machine has multiple turrets, select the correct Transfer 

turret. 
6 If your steady rest is fitted to a turret, click the Turret control 

button and set the correct Location and Index position. 

7 Click Finish. 

A part_support_off feature is added to the Part View. You may 
need to drag the feature to a different position in the Part View 
and set a Base priority for the feature to set the correct order of 
features. 

To enable a tailstock: 
1 In the turning New Feature wizard, select the Part Handling 

feature and click Next. 
2 Select Part Support On and enter a value for the Grab distance. 

This is the distance in Z where you want to use the steady rest. 

3 Click Next. 
4 For the Support type, select Tailstock. 

5 If your machine has multiple turrets, select the correct Transfer 
turret. 

6 If your tailstock is fitted to a turret, click the Turret control button 
and set the correct Index position. 

7 Click Finish. 

A part_support_on feature is added to the Part View. You may 
need to drag the feature to a different position in the Part View 
and set a Base priority for the feature to set the correct order of 
features. 

To disable a tailstock: 
1 In the turning New Feature wizard, select the Part Handling 

feature and click Next. 
2 Select Part Support Off and enter a value for the Grab distance. 

This is the distance in Z where you want to use the steady rest. 

3 Click Next. 
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4 For the Support type, select Tailstock. 

5 If your machine has multiple turrets, select the correct Transfer 
turret. 

6 If your tailstock is fitted to a turret, click the Turret control button 
and set the correct Location and Index position. 

7 Click Finish. 

A part_support_off feature is added to the Part View. You may 
need to drag the feature to a different position in the Part View 
and set a Base priority for the feature to set the correct order of 
features. 

 

Machine simulation improvements 
(MSIM) 

FeatureCAM 2014 R1 includes these machine simulation 
improvements: 

 You can now show edges (see page 73) during machine 
simulation. 

 Jaws, steady rest, and tailstock (see page 70) are now supported 
for turning machine simulation. 

 For machines with two spindles, you can play the simulation once 
only (see page 75). 

 

Show edges 
In FeatureCAM 2014 R1, there is a new Show edges option for 
machine simulation: 
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Select this option to use an outline for the edges of the machine. 
You can see the machine edges more clearly using this option. 

This example shows the default behavior with Show edges 
deselected: 

 
This is the same example with Show edges selected: 
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Play simulation once 
In FeatureCAM 2014 R1, there is a new Only Play Sim Once option in 
Simulation Options: 

 
For some machines with two spindles, the simulation plays through 
the simulation twice. If you want to see the part simulated only 
once, select this option. 

 

Machine design improvements (MSIM) 
FeatureCAM 2014 R1 includes these machine simulation 
improvements: 

 You can now replace a solid (see page 75) and keep the 
attributes of the original. 

 It is now easier to define parent/child relationships (see page 
76). 

 Is is now simpler to create milling machines (see page 77). 

 You get feedback when a UCS is not set (see page 77). 
 

Replace solid 
There is a new Replace Solid dialog for machine design in 
FeatureCAM 2014 R1. To open it, select Machine Design > Replace 
Solid from the menu. 



 

76 • What's New in FeatureCAM 2014 R1 FeatureCAM 2014 R3 What's New  

Use the Replace Solid dialog to replace solid1 with solid2, and keep 
the machine design attributes from solid1, such as parent/child 
relationships, movement, and so on. 

 
 

Easier relationship definitions 
In FeatureCAM 2014 R1, there are two new arrow buttons in the 
Parent/Child Relationships dialog: 

 
As you work up or down through the machine hierarchy, you can 
save time by moving the previously selected solid from the parent to 
the child selection or the child to the parent selection using the 
arrow buttons. 
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Simplified milling machine interface 
Machine design now shows only the options relevant to a milling 
machine, by default in the user interface. The options relevant to 
turning machines are unavailable in the menu, until you select the 
new Enable Millturn UI menu option: 

 
 

Improved user interface 
In FeatureCAM 2014 R1, you get feedback when you have not yet 
set a UCS, for example: 
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Probing improvements 
FeatureCAM 2014 R1 includes these improvements to the Probing 
add-in: 

 You can now edit default values (see page 78). 

 There are three new decision-making features (see page 79). 

 Turn/mill probing simulation (see page 82) has been improved. 
 

Edit default values 
In FeatureCAM 2014 R1, default measurement attributes have been 
added to the Probing Settings dialog: 

 
You can edit the default values of any of these attributes. Click the 
Reset Defaults button to return to the original values. 

 



 

FeatureCAM 2014 R3 What's New What's New in FeatureCAM 2014 R1 • 79  

Decision-making features 
It is easier to program probing in FeatureCAM 2014 R1, using 
decision-making features. 

There are three decision-making features: 

 
 Test Abort/Continue — Based on the results of your 

measurement, this feature type aborts the current milling 
process or continues as normal. 

 Test Abort/Continue/Remachine — Based on the results of your 
measurement, this feature type aborts the current milling 
process, continues as normal, or remachines the feature. 

 Test Jump Label — Places an N block number label in the NC code 
that the program can use, for example a start label, or a place in 
the code to jump to. 

Decision-making example 
This example part has many features. 
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After milling a Face feature, the first Bore feature  is milled, then 
the second Bore feature , followed by the rest of the features. To 
avoid unnecessary machining time, you can probe Bore  after it is 
cut and make a decision whether to continue, remachine it, or abort 
the program, depending on the results of the probe. 

1 Create a Test Jump Label feature to start the process. 

 
The NC code for this Test Jump Label feature reads: 
(Test Jump Label PROBEOPER TEST_JUMP_LABEL1) 
(Start Bore) 
#101=0 
N11 

2 You want the decision-making process to start after the Face 
feature, so set the Base priority for the Test Jump Label to 2, and 
drag the feature to the correct place in the Part View. 

3 Create a Measure Boss/Bore feature to probe Bore1 after it has 
been milled. 

4 Create a Test Abort/Continue/Remachine feature to control what 
happens after the probing. For this example the following values 
are set: 

Nominal Value 27.000 

Tolerance Value 0.050 

Continue Label 12 

Remachine Label 11 (the value that was set for the starting Test 
Jump Label) 

Size Error 13 

5 Set the Base priority to 5 because you want this to be the 5th 
feature (after the Face feature, starting Test Jump Label, Bore1 
feature, and Measure Boss/Bore feature). 
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The NC code for this Test Abort/Continue/Remachine feature 
reads: 
( Test Abort/Continue/Remachine  PROBEOPER  
TEST_ABORT_CONTINUE_REMACHINE1 ) 
(Remachining check conditional) 
(Begin decision sequence) 
#102=27  (nominal value) 
#104=[#102-#510]  (signed difference of actual from 
nominal) 
#103=0.05 (tolerance value) 
(Decision 1) 
IF [ABS[#104]LT#103] GOTO 12  (within tolerance case) 
(Decision 2) 
IF [#104LT0]GOTO 13 
(Decision 1 and 2 skipped) 
[#101=#101+1] 
IF [#101EQ1] GOTO 11 (run toolpath again) 
DPRNT[Error: Second Required Remachining] 
GOTO 99999 
(Decision 2 result) 
N13 
DPRNT[Error: Too Big] 
GOTO 99999 
(Decision 1 result) 
N12 
N835 M5 M9 
N840 G91 Z0 
N845 M01 
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6 Create an Abort label at the end of the NC code: 

 
7 Set its Base priority to a large number, such as 100. 

The NC code for this Test Jump Label feature reads: 
( Test Jump Label  PROBEOPER  TEST_JUMP_LABEL3 ) 
(Abort) 
#101=0 
N99999 

 

Turn/mill probing simulation improved 
The accuracy of turn/mill probing simulation has been improved by 
handling rotary indexing moves. 
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XBUILD improvements 
FeatureCAM 2014 R1 includes these XBUILD improvements: 

 There is a new <INDEX-AXIS> (see page 83) reserved word. 

 There is a new Don't output retract to Z index clearance moves (see 
page 83) option for use with the Smith Bits APT post. 

 You can now set the Force segment start for each operation (see 
page 84) option in XBUILD. 

 

New reserved words 
<INDEX-AXIS> Returns the index axis (X, Y, or Z) for 4th-axis 

indexed parts, otherwise returns None. 

 
 

Z index clearance optional 
There is a new Don't output retract to Z index clearance moves option 
in XBUILD. If you are using the Smith Bits APT post, you must 
select this option. This enables the correct APT code to be output for 
hole canned cycles that are not aligned with the Z-axis in RTCP 
(Rotational Tool Center Point). 

 
 



 

84 • What's New in FeatureCAM 2014 R1 FeatureCAM 2014 R3 What's New  

Force segment start option moved 
In FeatureCAM 2014 R1, you can set the Force segment start for each 
operation option in XBUILD in the General Information dialog. 

 
The previous and default behavior is to set this option in the Post 
Options dialog in FeatureCAM: 

 
If you select ON or OFF in XBUILD, the status is displayed in the 
Post Options dialog. 
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